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C H A P T E R 1

Introduction and Roadmap

The following sections describe the contents and audience for this guide— Using the WebLogic 
Diagnostic Framework Console Extension:

“What Is the WebLogic Diagnostic Framework Console Extension?” on page 1-1

“Document Scope and Audience” on page 1-2

“Guide to This Document” on page 1-2

“Related Documentation” on page 1-2

“New and Changed Features in this Release” on page 1-3

What Is the WebLogic Diagnostic Framework Console 
Extension?

The WebLogic Diagnostic Framework (WLDF) Console Extension is a part of the WebLogic 
Diagnostic Framework that provides views and tools for graphically presenting diagnostic data 
about servers and applications running on them. The underlying functionality for generating, 
retrieving, and persisting diagnostic data is provided by the WLDF framework, and the WLDF 
Console Extension provides additional tools for presenting that data in tables, charts, and graphs.

The WLDF Console Extension is implemented as an extension to the BEA WebLogic Server® 
Administration Console, using the WebLogic Server Console Extension architecture (see 
Extending the Administration Console). 

http://e-docs.bea.com/wls/docs91/console_ext/index.html
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The WLDF Console Extension is included with WebLogic Server 9.1, but you must install it 
manually. See Chapter 2, “Installing and Displaying the WLDF Console Extension.”

Document Scope and Audience
This document describes WLDF Console Extension features and installation procedures. It is 
written for system administrators or anyone who wants to view graphic representations of 
diagnostic data for WebLogic Server instances and applications deployed to them.

It is assumed that readers are familiar with Web technologies and the operating system and 
platform where WebLogic Server is installed.

Guide to This Document
This document is organized as follows:

This chapter, “Introduction and Roadmap,” is an overview of the WLDF Console 
Extension and describes the audience for this guide.

Chapter 2, “Installing and Displaying the WLDF Console Extension,” tells how to install 
and display the WLDF Console Extension.

Chapter 3, “Overview of the WLDF Console Extension,” describes the features and the 
user interface of the WLDF Console Extension.

Chapter 4, “Understanding How Data Is Collected and Presented,” describes how server 
and application diagnostic data is collected, maintained, and displayed by the WLDF 
Console Extension.

Chapter 5, “Working with Views,” describes how to create, modify, and use views, which 
are panels that contain charts and graphs.

Chapter 6, “Creating and Modifying Charts and Graphs,” describes how to create, modify, 
and use charts and graphs, which graphically display the diagnostic data.

Appendix A, “Keyboard Reference,” describes how to use the keyboard (instead of the 
mouse) to accomplish tasks in the WLDF Console Extension.

Related Documentation
Configuring and Using the WebLogic Diagnostic Framework describes how to configure 
and use WLDF.

http://e-docs.bea.com/wls/docs91/wldf_configuring/index.html
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“Configure the WebLogic Diagnostic Framework” in the Administration Console Online 
Help describes how to use the WebLogic Administration Console to configure WLDF.

New and Changed Features in this Release
The WLDF Console Extension is new in WebLogic Server release 9.1. This functionality was not 
available in previous releases.

http://e-docs.bea.com/wls/docs91/ConsoleHelp/taskhelp/diagnostics/ConfigureWebLogicDiagnosticFramework.html
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C H A P T E R 2

Installing and Displaying the WLDF 
Console Extension

The WebLogic Diagnostic Framework (WLDF) Console Extension is included with BEA 
WebLogic Server®, but it is not installed by default. The following section describes how to 
install and display the WLDF Console Extension:

“Installing the WLDF Console Extension” on page 2-1

“Displaying the WLDF Console Extension” on page 2-3

Installing the WLDF Console Extension
The WLDF Console Extension is delivered as a Java Archive (JAR) file, named 
diagnostics-console-extension.jar. You must install this JAR file into the 
Administration Server for a domain for the WLDF Console Extension to be incorporated into the 
WebLogic Server Console for that domain.

Installation Prerequisites
Before you can install and run the WLDF Console Extension, you need:

BEA WebLogic Server 9.1 installed

A Web browser that meets the requirements for running the BEA Weblogic Server 9.1 
Administration Console

Java Plug-in version 1.5 (J2SE Runtime Environment 5.0)

Java and Javascript enabled in your browser
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Installing the Java Plug-in 
If the Java plug-in 1.5 is not already installed in your Web browser, you will be prompted to 
initiate a download from the Sun Microsystems Java Web site. Follow the instructions on screen.

Alternatively, install the plug-in manually when you begin the installation process for the WLDF 
Console Extension:

1. Go the Java Software download page, at:

http://java.com/en/download/

2. Follow the instructions on screen.

Installing the WLDF Console Extension
To install the WLDF Console Extension:

1. Find the diagnostics-console-extension.jar file in the 
WL_HOME\server\lib\console-ext directory, where WL_HOME is the directory in which 
you installed WebLogic Server. 

2. Copy diagnostics-console-extension.jar into the DOMAIN-DIR/console-ext 
directory for every domain in which you want to use the Console Extension, where 
DOMAIN-DIR is the domain's root directory. 

For example, to display diagnostic data for the sample Medrec server that is included with 
WebLogic Server, copy diagnostics-console-extension.jar to 
DRIVE:\\BEA-HOME\weblogic90\samples\domains\medrec\console-ext.

3. Restart the Administration Server for the domain where you installed the extension. The 
Administration Console for the domain is then deployed with the WLDF Console 
Extension.

Removing the WLDF Console Extension
To remove the extension:

1. Stop the Administration Server.

2. Delete the JAR file from the DOMAIN-DIR/console-ext directory and restart the 
Administration Server.
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Displaying the WLDF Console Extension
When you launch an Administration Console in which the WLDF Console Extension is installed, 
the Console appears with two tabs, BEA WLS Console and WLDF Console Extension, as 
shown in Figure 2-1. 

Figure 2-1  Console Extension Tab

By default, the BEA WLS Console tab is initially selected on login, which shows the standard 
Administration Console. Select WLDF Console Extension to display the extension.

These two tabs are always present, so you can easily move back and forth between the primary 
Administration Console pages and the WLDF Console Extension.

Note: All WLDF Console Extension functionality occurs in the context of a Java applet.  Each 
time you select the WLDF Console Extension tab, the applet is loaded. 

When you select the BEA WLS Console tab, the applet is unloaded, and you are returned 
to the Administration Console context that existed before you displayed the WLDF 
Console Extension.  All activity related to the applet and the WLDF Console Extension 
is terminated. 
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C H A P T E R 3

Overview of the WLDF Console 
Extension

The WLDF Console Extension provides a set of visual tools you can use to directly manipulate 
objects to display diagnostic information about WebLogic Server instances. The following 
sections provide a high level overview:

“Scope of the Diagnostic Information Displayed”

“Two Main Panels”

“View Panel Overview”

“Tabs Panel Overview”

“Toolbar and Scrollbar Overview”

“Displaying Tooltips for Controls, Views, Graphs, and Charts”

“Creating Views, Graphs, and Charts: Main Steps”

“Alternative Ways to Manipulate Objects”

Scope of the Diagnostic Information Displayed
You install the WLDF Console Extension into a domain, and you can display diagnostic data 
about any of the server instances in that domain and about applications running on those servers.
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Two Main Panels
The WLDF Console Extension has two panels, the Tabs panel and the View panel, plus a toolbar 
and a status bar, as shown in Figure 3-1. 

Figure 3-1  WLDF Console Extension Panels

View Panel Overview
A view is a collection of one or more charts, which display captured monitoring and diagnostic 
data, as shown in Figure 3-2 and Figure 3-3. Views are displayed in the View panel, on the right 
side of the WLDF Console Extension page. The View panel displays a single view at a time.
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Figure 3-2  A View Containing One Chart

Figure 3-3  A View Containing Three Charts

Each chart contains a legend, labels, and controls for identifying and displaying the data. A chart 
can display data from one or more data sources from one or more servers in the domain. The data 
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sources include one or more metrics (that is, the value of an MBean instance attribute) or one or 
more instrumented methods. Each data source is displayed as a distinct graph, which shows the 
values of data points over a time span. The relationship between views, charts, and graphs is 
shown in Figure 3-4. In the figure, the view contains two charts, “WLDF Metrics Chart” and 
“JVMRuntime@MedRecServer,” based on metrics data from the MedRecServer server. “WLDF 
Metrics Chart” contains one Metrics graph, “UpTime@MedRecServer.” The 
“JVMRuntime@MedRecServer” chart contains two Metrics graphs, 
HeapSizeCurrent@MedRecServer” and “HeapFreeCurrent@MedRecServer.”

Note: A chart can include graphs based on data from one or more servers in the domain.

Figure 3-4  Relationships of Graphs to Charts and of Charts to Views
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Tabs Panel Overview
The Tabs panel, on the left side of the page, contains tabs with controls for creating and 
modifying the views and charts that are displayed in the View panel, on the right.

The Tabs panel contains four tabs:

Views contains a list of built-in views and custom views. It also contains controls for 
creating, modifying, and deleting views. See Chapter 5, “Working with Views.”

Metrics contains a tree of all known runtime MBean types, instances, and attributes for the 
selected server. You can drag attributes onto a view to create one or more graphs that show 
the state of those attributes over time. See Chapter 6, “Creating and Modifying Charts and 
Graphs.” 

Requests contains a tree of events generated by instrumented code in the selected server. 
You can drag methods onto a view to create a graph that shows the execution performance 
(that is, the elapsed performance time) of those methods over time. See Chapter 6, 
“Creating and Modifying Charts and Graphs.”

Note: You must configure WLDF instrumentation for a server outside of the WLDF 
Console Extension for data to appear in this tab. See “Making Instrumentation Data 
Available for Method Performance Charts” on page 6-26.

Properties contains two subtabs:

– Use the controls in the Properties > Selected Item Properties tab to change the 
appearance of individual graphs and charts. See “Setting Chart Properties” on 
page 6-16 and “Setting Graph Properties” on page 6-21.

– Use the controls in the Properties > Global Properties tab to set polling and display 
properties that apply to all active views. See “Setting Global Polling and View 
Scrolling Properties” on page 6-33.

Toolbar and Scrollbar Overview
The toolbar and scrollbar are available at all times, regardless of which tab is displayed in the 
Tabs panel.
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The toolbar is displayed directly above the Tabs and View panels. The buttons and icon in the 
toolbar are described in Table 3-1. 

The status bar at the bottom of the page displays information about the selected item. 

Displaying Tooltips for Controls, Views, Graphs, and Charts
You can display short messages, called tooltips, about several types of objects in the WLDF 
Console Extension by positioning the mouse pointer over the objects. To display a tooltip for an 
item, move the mouse pointer to point to the object, and pause. Do not click the mouse. After a 
momentary delay, a short message about the item is displayed.

In all areas of the WLDF Console Extension, you can display tooltips for standard controls such 
as buttons, text fields, sliders, and so forth, which tell you what each control does. But you can 
also display details about other objects displayed in the WLDF Console Extension and about the 
sources from which the diagnostic data is gathered, as described in the following sections:

Table 3-1  Buttons and Icon in the Toolbar

Button or Icon Description Action

Focus context Click to change focus between the Tabs panel to the View panel.

Save all 
modified 
views

Click to save all custom views. If no views have been modified since 
they were last saved, this button is disabled and is colored gray.

Stop all active 
views

Click to stop all active views.

Delete Click to delete selected graph or chart.

Status of data 
polling

Displays the status of the data poller:
• Green indicates that data is being retrieved from the server with 

no problem.
• Yellow indicates that there are some problems retrieving data 

from the server.
• Red indicates that no data is being retrieved from the server.
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“Displaying Details About MBean Instances and Attributes in the Metrics Tab” on 
page 6-25 

“Displaying Details About Metrics Charts and Graphs” on page 6-25 

“Displaying Details About Requests” on page 6-28 

“Displaying Details About Instrumentation Events” on page 6-29 

“Displaying Details about Requests and Methods in the Requests Tab” on page 6-31 

“Displaying Details About Method Performance Charts” on page 6-32 

Creating Views, Graphs, and Charts: Main Steps
To create a view and add charts and graphs:

1. From the Views tab, create or select a view. See Chapter 5, “Working with Views.”

2. Select which kind of chart you want to create:

– Use the Metrics tab to create a Metrics chart, or 

– Use the Requests tab to create a Method Performance chart.

See Chapter 6, “Creating and Modifying Charts and Graphs.”

3. In the Metrics tab or Requests tab, select the server for which you want to display 
diagnostic data. See Chapter 6, “Creating and Modifying Charts and Graphs.”

4. Drag items from the Metrics or Requests tab in the left panel to the active view in the right 
panel. Drop an item into a blank area in the view to create a new chart and graph, or drop it 
into an existing chart to add a new graph to the other graph(s) in the chart. See Chapter 6, 
“Creating and Modifying Charts and Graphs.”

5. Optionally, select the Properties tab, and use the tools on that tab to change the appearance 
of graph(s) and chart(s). See Chapter 6, “Creating and Modifying Charts and Graphs.”

6. If are working with a custom view, save the view. See Chapter 5, “Working with Views.”

Alternative Ways to Manipulate Objects
The WLDF Console Extension is a graphical user interface with visual tools for setting attributes 
and manipulating objects. Alternative interaction techniques are available for accomplishing 
many activities:
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Drag and drop and other direct manipulation with the mouse. For example, you can 
drag an MBean instance attribute from the Tabs panel to the View panel to create a new 
chart. Another direct manipulation technique is to Shift-drag across a graph in a chart to 
zoom in on the data.

Right-click, then select from a context menu. You can right-click attributes in the 
Metrics tab, methods in the Requests tab, and charts in the View panel to display context 
menus, from which you can select a command to act on the selected object. For example, 
you can right-click an MBean instance attribute in the Tabs panel, then choose Create 
New Chart to incorporate it into a new chart.

Keyboard interaction. You can use the Tab key, the arrow keys, and the Enter key to 
select different tools and objects on the page and then perform actions on them. For full 
documentation, see Appendix A, “Keyboard Reference.”
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C H A P T E R 4

Understanding How Data Is Collected 
and Presented

The following sections describe the relationship between and the process of data collection and 
presentation in the WLDF Console Extension:

“Overview of Data Collection and Presentation”

“How Metrics Data Is Collected and Presented”

“How Instrumentation Data Is Collected and Presented”

Overview of Data Collection and Presentation
In a standard WLDF configuration, you can configure the Harvester to collect metrics for 
specified attributes of specified MBean instances. This information is available for programmatic 
access, and it is written to a standard log, HarvestedDataArchive, which you can view through 
the standard Administration Console. See “Configuring the Harvester for Metric Collection” in 
Configuring and Using the WebLogic Diagnostic Framework. 

You can also configure the Instrumentation component to generate events called diagnostic 
actions when certain conditions are met in instrumented code. See “Configuring Instrumentation” 
in Configuring and Using the WebLogic Diagnostic Framework. This information, too, is 
persisted in a standard log, EventsDataArchive., which you can view through the standard 
Administration Console. 

Those WLDF components and log files enable you to display data in the WLDF Console 
Extension:

http://e-docs.bea.com/wls/docs91/wldf_configuring/index.html
http://e-docs.bea.com/wls/docs91/wldf_configuring/config_instrumentation.html
http://e-docs.bea.com/wls/docs91/wldf_configuring/index.html
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To view current metrics data in the WLDF Console Extension, it is not necessary to 
configure the Harvester. Data is retrieved from a data cache on the server. However, to see 
historical metric data, you must configure the Harvester to collect the data you want to 
monitor. Historical data is always retrieved from the HarvestedDataArchive log. See 
“How Metrics Data Is Collected and Presented” on page 4-2.

To view current and historical data for instrumented methods, you must configure 
Instrumentation as part of the WLDF configuration for the server. Instrumentation data 
displayed in the WLDF Console Extension is always retrieved from the 
EventsDataArchive log. See “How Instrumentation Data Is Collected and Presented” on 
page 4-5.

Data displayed in the WLDF Console Extension is generated, collected, and optionally persisted 
on the server, and the WLDF Console Extension on the client periodically polls that data for 
display in a chart.

How Metrics Data Is Collected and Presented
When a view containing one or more Metrics charts is activated in the WLDF Console Extension, 
data collection for viewing those metrics in real time is started on the server. The data collector 
continually gathers the data and places it in a “wrap-around” cache. That is, as new data fills the 
cache, the oldest data in the cache is lost. When a view is stopped (see “Starting and Stopping a 
View” on page 5-6), data collection for the contained charts is stopped. However, if the Harvester 
is configured to collect data for a metric, that data will continue to be harvested and persisted to 
the log.

To display current data, the WLDF Console Extension periodically polls the cache for a current 
data set and displays it in a chart. 

Note: The size of the data set returned to the client is configurable. See “Setting Global Polling 
and View Scrolling Properties.”

To display current metric data, no prior WLDF configuration is required. However, to display 
historical data for a metric, the WLDF Harvester must have been configured to harvest that data.

The following four illustrations (Figure 4-1, Figure 4-2, Figure 4-3, and Figure 4-4) show how 
metric data is retrieved and displayed for present and historical data, with and without harvesting. 

These conceptual illustrations show a timeline from server startup to the present:

1. The tail of the arrow, on the left, represents the time when the server was started. The tip of 
the arrow, on the right, represents the present.



How Met r ics  Data  I s  Co l l ec ted  and  Presented

Using  the WebLogic Diagnostic Framework Console Extension 4-3

2. The point in the middle of the arrow represents the time when a view containing the Metrics 
chart was activated and, therefore, when the Console Extension client started polling for 
data to display for that metric.

3. The oval represents the range of data that is being displayed in a chart in the Console 
Extension, sometimes called the viewport. 

The data cache always contains the most current data. But if polling has been taking place 
long enough for old data to be purged, the cache does not contain all data from the time 
polling started. That is why the range of data shown through the viewport is not equivalent 
to the range of data collected since polling began.

If the Harvester was not configured to harvest data for this metric, no historical data is 
available for the metric and therefore cannot be displayed in the WLDF Console Extension 
client. If the Harvester was configured to harvest data for this metric, historical data is 
available for the metric and can be displayed by scrolling back through a chart (see 
“Scrolling and Zooming the Data Displayed in a Chart.”

Figure 4-1 illustrates the following scenario:

1. When the server starts, the Harvester is not configured for the metric. Therefore, no data is 
saved for later retrieval.

2. At some point after the server is started, the Console Extension is started and the view 
containing the Metrics chart is activated. Polling for the metric begins, and the current data 
fills the cache.

3. The Metrics chart shows current data from the cache. If you tried to scroll to see historical 
data, you could not see any, since none is available.

Figure 4-1  No Harvesting; Display Current Data

Figure 4-2 illustrates the following scenario:
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1. When the server starts, the Harvester is configured for the metric and starts to harvest data 
when the server is started. The data is persisted to the archive, and it can be retrieved for 
viewing.

2. At some point after the server was started, the Console Extension is started and the view 
containing the Metrics chart is activated. Polling for the metric begins, and the current data 
fills the cache.

3. The Metrics chart, displayed in the client, shows current data from the cache. Because the 
data was harvested and archived, you can scroll the chart to see historical data. However, in 
this illustration, the chart is still set to display current data. Even though data for the metric 
is being saved in the archive, the current data is still retrieved from the cache.

Figure 4-2  Harvesting; Display Current Data

The scenario in Figure 4-3 shows the same scenario as in Figure 4-2, but in this case, the chart is 
scrolled to show historical data. All data is retrieved from the archive. Current data continues to 
fill the cache, but that data is not currently used.

Figure 4-3  Harvesting; Display Historical Data
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The scenario in Figure 4-4 shows the same scenario as in Figure 4-2 and Figure 4-3, but in this 
case, the chart is scrolled to show some historical data and some current data. The historical data 
is retrieved from the archive, and the current data is taken from the cache.

Figure 4-4  Harvesting; Display Current and Historical Data

How Instrumentation Data Is Collected and Presented
For instrumentation data to be displayed in a chart, instrumentation must be configured in the 
WLDF configuration on the server. Data is always retrieved from the persisted store. If 
instrumentation is not configured and activated for a server, you will not be able to see any events 
in the Requests tab.
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C H A P T E R 5

Working with Views

A view is a named collection of charts and graphs that present graphical information of similar 
diagnostic type data. The following sections describe how to work with views:

“The Views Tab and the View Panel”

“Displaying and Modifying an Existing View”

“Creating a Custom View”

“Creating a View Based on an Existing View (Cloning)”

“Changing the Name of a View”

“Saving A Custom View”

“Deleting a View”

“Starting and Stopping a View”

The Views Tab and the View Panel
The Views tab in the Tabs panel, on the left side of the page, contains a list views for all running 
servers in the domain. It also provides the means to create, select, modify, and delete views. When 
you select (click) the name of a view in the Views tab on the left, the view is displayed in the 
View panel on the right, as shown in Figure 5-1. That view remains displayed in the View panel, 
even when you select different tabs in the Tabs panel.
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Figure 5-1  Views Tab and View Panel

The Views tab lists both built-in and custom views. 

The Built-in views are a set of predefined views of available runtime metrics for all running 
WebLogic Server instances in the domain.  These views surface some of the more critical 
runtime WebLogic Server performance metrics and serve as examples of the WLDF 
Console Extension’s view and graphing capabilities.

Built-in views are installed when you install the the WLDF Console Extension, and they 
are available for every user logged into the Administration Console and using the WLDF 
Console Extension. 

You can modify a built-in view, but the modification is only visible during your current 
session; it is lost when you switch back to the primary Administration Console view. Also, 
no other user can access the modified view. If you want to modify and save one of the 
built-in views, you can clone it and save it as a custom view.
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A custom view is any view created by a user. Custom views are available only to the user 
who created them. You can save a custom view and access it again when needed. 

WLDF Console Extension provides no pre-defined custom views.

The charts and graphs in a view can display diagnostic data for any of the servers running in the 
domain.

The views listed in the Views tab are displayed in separate trees, as shown in Figure 5-2.

Figure 5-2  Built-in and Custom Views Displayed in the View Tab

Table 5-1 describes the visual cues that help identify the views in the Views tab.

Table 5-1  Views Tab Icons

Visual Cue Description Description

Green icon adjacent 
to a view name

The view is active and data polling is 
occurring for all charts in that view.  
(This is true whether or not the view is 
currently displayed in the View panel.)

Yellow icon 
adjacent to a view 
name

The view is inactive and data polling 
is not occurring for the charts in that 
view. 
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Displaying and Modifying an Existing View
To display and modify an existing view:

1. Select the Views tab to display the list of available views. 

2. Click the name of the view. The view appears in the View panel, replacing the view that is 
currently displayed. (Only one view can be displayed at a time.) 

3. Add and modify charts, as desired. See Chapter 6, “Creating and Modifying Charts and 
Graphs.”

4. Save the view (custom views only):

– In the Views tab, click the Save button, or 

– On the toolbar, click the  (Save All Modified Views) button.

Creating a Custom View
To create and display a new custom view:

1. Click the Views tab. 

2. In the text field at the bottom of the browser, enter a name for the view.

3. Click Create to create the view. The new, empty view is displayed in the View panel.

4. Add and modify charts, as desired. See Chapter 6, “Creating and Modifying Charts and 
Graphs.”

5. Save the view:

– In the Views tab, click the Save button, or 

View name in bold 
font

The view is the default view.

View name in italic 
font

The view has not yet been saved.

Table 5-1  Views Tab Icons

Visual Cue Description Description
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– On the toolbar, click the  (Save All Modified Views) button.

Creating a View Based on an Existing View (Cloning)
To create and display a view based on an existing view:

1. Select the Views tab. 

2. Click the name of the existing view on which you want to base a new view.

3. In the text field at the bottom of the browser, enter a name for the new view.

4. Click Clone, at the bottom of the Views tab, to copy the current view with a new name. The 
new, cloned view is displayed in the View panel. Until you make changes, the cloned view 
has the same properties as the view upon which it is based.

5. Add and modify charts, as desired. See Chapter 6, “Creating and Modifying Charts and 
Graphs.”

6. Save the view:

– In the Views tab, click the Save button, or 

– On the toolbar, click the  (Save All Modified Views) button.

Changing the Name of a View
You can change the names of custom views only. To change the name of a view:

1. Select the Views tab.

2. Right-click the name of the view you want to rename, select Rename, and type a new 
name. Alternatively, in the View panel, right-click the name of the current view at the top of 
the panel. Then type a new name in the field.

3. In the Views tab, click the Save button.

Saving A Custom View
While you can modify any view for the current session, you can save only custom views. To save 
a custom view:

1. Select the Views tab. 
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2. Click the name of the custom view you want to save.

3. Click the Save button.

Alternatively, click the  (Save All Modified Views) button on the toolbar.

Deleting a View
You can only delete custom views. To delete a custom view:

1. Select the Views tab.

2. Click the name of the view you want to delete.

3. Click the  (Delete) button in the toolbar. Alternatively, right-click the name of the view 
and select Delete from the context menu. 

Starting and Stopping a View
When you start a view, polling commences for the charts in the view. That is, the client starts 
polling for data from the server, so that the data can be represented in one or more graphs. When 
you stop a view, polling for the view ends.

To start a view:

1. Select the Views tab.

2. Right-click the view you want to start, and select Start from the context menu.

To stop a view:

1. Click the Views tab.

2. Right-click the view you want to stop, and select Stop from the context menu.

To stop all views, click the  (Stop All Active Views) button on the toolbar to stop all active 
views.

Note: Current data for Metrics charts is polled from a data cache on the server. Historical data 
for Metrics charts and all data for Method Performance charts are retrieved from data 
archives. If you stop all views, data is no longer added to the data cache on the server. 
For more information, see Chapter 4, “Understanding How Data Is Collected and 
Presented.”
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C H A P T E R 6

Creating and Modifying Charts and 
Graphs

The WLDF Console Extension supports two types of charts and graphs:

Metrics charts contain one or more graphs that display real-time and harvested MBean 
metric information. 

Method Performance charts contain one or more graphs displaying elapsed time 
information for a given instrumented method. 

Both kinds of charts can display information from one or more running server instances in the 
domain.

Many of the tasks you perform when working with charts are the same for both types. Some tasks 
are different for the different types. The following sections describe how to work with charts:

“Working with Both Types of Charts and Graphs” on page 6-1

“Working with Metrics Charts and Graphs” on page 6-23

“Working with Method Performance Charts and Graphs” on page 6-26

“Setting Global Polling and View Scrolling Properties” on page 6-33

Working with Both Types of Charts and Graphs
The following sections describe how to work with charts and graphs.
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The Parts of a Chart
A chart consists of the following:

One or more graphs that show data points over a specified time span

X- and Y-axes for plotting diagnostic data

– Plots against a time-based X-axis.

– Provides a scaled Y-axis, (adjusted based upon the plotted data series.)

A legend that identifies the scope of each of the graphs in the chart: 

– The legend for a Metrics chart uses the scope of the form 
attributeName@serverName

– The legend for a Method Performance chart uses the scope of the form 
methodName@serverName

The legend can be hidden or displayed.

A scrollbar with zoom controls for changing the time span displayed on the chart’s X-axis. 
The scrollbar can be hidden or displayed.

Optional Y-axis label

These parts are shown in Figure 6-1.

Figure 6-1  Parts of a Chart
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Several graph styles are available for presenting data: area, area radar, bar, plot, scatter plot, 
stacking area, and stacking bar. For instructions on how to set those styles, see “Setting a Chart 
Graphing Style” on page 6-18.

Adding Charts to Views
You create and add charts to views by dragging items from the Metrics tab or the Requests tab, 
as described in the following steps.

1. Select the Views tab and select the view to which you want to add a chart (or create a new 
view). Figure 6-2 shows an empty view.

Figure 6-2  Empty View

2. Select the Metrics tab to create a chart based on metrics, or select the Requests tab to 
create a chart based on events generated by instrumented methods.

3. Drag a valid item from the tree to the view. The cursor changes shape, and the background 
darkens when you drag it into an area where you can insert a chart, as shown in Figure 6-3. 
For information about what items can be dragged from the Metrics tab, see “Working with 
Metrics Charts and Graphs” on page 6-23. For information about what items can be dragged 
from the Requests tab, see “Working with Metrics Charts and Graphs” on page 6-23.
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Figure 6-3  Dragging a Metric to Create a New Chart in an Empty View

When you release the mouse button, a chart is created that contains a graph based on the 
item you dragged from the tree in the left panel, as shown in Figure 6-4.
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Figure 6-4  A Chart in a View

Note: An alternative to dragging an item into a chart is as follows:

Right-click the item in left panel (the Metrics tab or the Request tab). The Add to 
Chart menu is displayed.

Select Create New Chart to create a new chart containing a graph based on the 
selected item, or select the name of an existing chart to add a graph to that chart.

4. To add another chart to the view, drag another item from the tree to a position above, below, 
or to the side of an existing chart. Figure 6-5 shows an item dragged to the right of a chart.
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Figure 6-5  Dragging a Metric Into an Existing View to Create a Second Chart

The new chart appears where it was dropped, as shown in Figure 6-6. All charts in the 
view are resized to fit together.
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Figure 6-6  Two Charts in a View

Creating an Empty Chart
To create an empty chart:

1. Right-click anywhere in a view.

2. Select New Chart. You can now add one or more graphs to the chart, as explained in 
“Adding Graphs to Existing Charts” on page 6-7.

Adding Graphs to Existing Charts
To graph data from more than one data source on the same chart (that is to add a graph to an 
existing chart), drag the appropriate item from the Metrics tab or the Requests tab to the existing 
graph in the View panel, as described in the following steps:

1. Select the Views tab to display the list of views.

2. Click the view containing the chart to which you want to add another graph (data source). 
Figure 6-7 shows a chart with one graph.
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Figure 6-7  Chart with One Graph

3. Select the Metrics tab to add a graph based on metrics, or click the Requests tab to add a 
graph based on instrumentation events.

Note: All graphs in a chart must be based on the same type of diagnostic data. That is, you 
cannot add metrics data to a Method Performance chart or instrumentation data to a 
Metrics chart.

4. Drag a valid item from the tree to the view, as shown in Figure 6-3. For information about 
what items can be dragged from the Metrics tab, see “Working with Metrics Charts and 
Graphs” on page 6-23. For information about what items can be dragged from the Requests 
tab, see “Working with Method Performance Charts and Graphs” on page 6-26.
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Figure 6-8  Dragging a New Diagnostic Data Source to an Existing Chart

The new graph is added to the chart, as shown in Figure 6-9.
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Figure 6-9  Resulting Graph with Two Charts

Note: An alternative to dragging an item into a chart is as follows:

Right-click the item in left panel (the Metrics tab or the Request tab). The Add to 
Chart menu is displayed.

Select Create New Chart to create a new chart containing a graph based on the 
selected item, or select the name of an existing chart to add a graph based on the 
item to that chart.

Repositioning a Chart
To reposition a chart in a view:

1. Select the Views tab and select the view containing the chart you want to reposition.
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2. Drag the chart to the new position in the view. That is, click the chart and hold the mouse 
button down while you drag. You position the chart above, below, to the left, or to the right 
of an existing chart. When the chart is in an acceptable position, a band of the background is 
darkened. This behavior is the same as when creating a new chart, as illustrated in 
Figure 6-5.

3. Release the mouse button.

Alternatively, right-click the chart, select Move Chart, and then select a new position from the 
context menu.

Merging Charts
To merge one chart with another:

1. Select the Views tab and select the view containing the charts you want to merge. All charts 
to be merged must be in the same view.

2. Drag the source chart onto the target chart. That is, click the chart and hold the mouse 
button down while you drag. When the source chart is positioned correctly over the target 
chart, the background of the target chart is darkened. 

3. Release the mouse button. 

All the graphs and associated legend entries of the source chart are added to the graphs and 
the legend of the target chart. Properties of the target chart--such as the title, colors, and 
the Y-axis label--are maintained, and any conflicting properties from the source chart are 
lost. Once successfully merged, the source chart is deleted.

Alternatively, right-click the chart, select Merge Chart, and then select the name of a chart with 
which to merge the current chart.

Moving a Graph to a Different Chart or to a New Chart
You can move a graph to a different chart only if the target chart does not already contain a graph 
based on the same data source. 

To move a graph from one chart to another:

1. Select the Views tab and select the view containing the graph you want to move. The source 
chart and the target chart must be in the same view.
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2. Shift-click the graph (or its legend entry) to select it. Release the Shift key and the mouse 
button, and do not click or select anything else until you perform the instructions in the 
following step.

3. Drag the graph from the source chart to the target chart or to an empty area in the view. That 
is, click the already selected graph and hold the mouse button down while you drag. When 
the graph is positioned correctly over the target chart (or over the empty area), the 
background of the target chart (or the empty area) is darkened. 

4. Release the mouse button. The graph and its legend are added to the target chart and 
removed from the source chart. If you dragged to an empty area, a new chart containing the 
graph is created.

Alternatively, click the chart to select it, and right-click to display the menu. Select Move Graph, 
which displays a list of all the graphs in the chart. Select the name of the graph you want to move. 
A list of all the charts in the view is displayed. Select the chart to which you want to move the 
graph, or select Create New Chart to create a new chart containing the selected graph. 

Starting and Stopping Data Collection for Charts in a View
To start data collection for the charts in a view:

1. Select the Views tab.

2. Click the name of the view you want to start. Alternatively, right-click the name of the view 
and select Start. The view is displayed in the View panel, and data collection begins.

To stop data collection for the charts in a view:

1. Select the Views tab.

2. Right-click the name of the view you want to stop and select Stop.

To stop all data collection for all views, click the  (Stop All Active Views) button in the 
toolbar. (It is not necessary to first select the Views tab.)

Scrolling and Zooming the Data Displayed in a Chart 
You can display or hide the scrollbar for a chart, as explained in “Turning a Chart Scrollbar On 
and Off” on page 6-20. The scrollbar includes controls for scrolling through data in the chart and 
for zooming in and out of the data in a chart.

The scrollbar and zoom controls are displayed below the chart, as shown in Figure 6-10.
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Figure 6-10  Scrollbar for a Chart

The scrollbar contains controls for scrolling through historical data and for zooming in and out 
of a set of data to change the time span displayed in the chart. The controls are shown in 
Table 6-1.

Table 6-1  Controls in the Scrollbar

Control Name Use

Thumb Drag to scroll through historical data.

Left scroll arrow Click to scroll backwards through historical data.

Right scroll arrow Click to scroll forwards through historical data.
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To hide the scrollbar for a chart:

1. Right-click anywhere in the chart.

2. Select Hide Scroll/Zoom Panel from the context menu.

Scrolling Through Historical Data in a Chart
Under certain circumstances, described below, you can scroll back and forth through a chart’s 
history, to see both historical and current data for the chart. Historical data is always retrieved 
from an archive, which means that historical data is only available if you have configured WLDF 
to gather metrics data (for Metrics charts) and/or if you have configured WLDF to gather 
instrumentation data (for Method Performance charts). For more information about how this is 
handled, see Chapter 4, “Understanding How Data Is Collected and Presented.”

To scroll through historical data:

1. Make sure that WLDF was configured to collect the metrics or instrumentation data you want 
to monitor. 

2. Select the chart containing the data you want to monitor.

3. Drag the scrollbar’s thumb control  to the interval you want to monitor. As you drag 
the thumb control, a message is displayed that shows the beginning and end times of the 
intervals you are scrolling through.

Alternatively, click  (left scroll arrow) to scroll backwards or click  (right scroll 
arrow) to scroll forward. Using these buttons advances or rewinds the displayed time 
interval by one minute.

To display current data after scrolling:

Zoom in Click to zoom into a data series, that is, to show an expanded view 
of the details in a shorter time span. Zooming in is useful when 
there are many data points crowded together in a short time span.

Zoom out Click to zoom out of a series of data, that is, to show data for a 
longer time span.

Table 6-1  Controls in the Scrollbar

Control Name Use
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1. Select the chart.

2. Do one of the following:

– Move the thumb control all the way to the right on the scroll bar, or

– Right-click the chart, then select View Current Data from the context menu.

Notes:

If no archived data is available for a Metrics graph, only the data available in the cache of 
actively polled metrics can be displayed.  If you scroll to a point earlier than the data 
available in the cache, no data is displayed for that graph.

While you scroll, a message is displayed showing the time intervals that you are scrolling 
through. When you stop scrolling, the data is retrieved for the selected interval. To display 
the dates and times for the visible interval, position the mouse pointer anywhere on the 
scrollbar.

Zooming In and Out of Data in a Chart 
You can zoom into the data shown in a chart to expand the view of data points for a shorter time 
span, and you can zoom out to show details about a longer time span.

Zoom in and out as follows:

To zoom in on the X-axis by intervals of 10% of the displayed time interval, click the 

 (Zoom in) button. You can zoom in to a minimum interval of 30 seconds.

To zoom out of the X-axis by intervals of 10% of the displayed time interval, click the 

 (Zoom out) button. You can zoom out to an interval of five minutes, which is the 
default interval.

To zoom in on the X-axis by a custom interval, Shift-drag over an area of the chart. That 
is, press and hold the Shift key, then drag the mouse pointer over the area of the chart you 
want to display. (You must release the mouse button before you release the Shift key.)

To reset the interval to its state before it was zoomed, do one of the following:

– Press the  (Zoom out) button until the zoom mode is exited

– Select the chart and press the r key on the keyboard

– Right-click the chart and select Zoom Reset (R) from the context menu
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Resetting the zoom state resets the interval back to the default interval of five minutes, 
starting at the start time which was in effect before zooming.

Deleting a Graph from a Chart
To delete a graph from a chart:

1. Select the Views tab and select the view containing the chart containing the graph you want 
to delete.

2. Select the graph in either of the following ways:

– Shift-click anywhere on the graph.

– Shift-click on the legend entry for the graph.

3. Click the  (Delete) button in the toolbar, or press the Delete key. The graph is 
permanently deleted and cannot be recovered. 

Deleting a Chart
To delete a chart:

1. Select the Views tab and select the view containing the chart you want to delete.

2. Click the chart. A border appears around the chart to show it has been selected.

3. Click the  (Delete) button in the toolbar, or press the Delete key.

The chart is permanently deleted and cannot be recovered.

Setting Chart Properties
When you create a chart, it is created with default visual and control properties. To change those 
properties:

1. Select the Views tab and select the view containing the chart whose properties you want to 
change.

2. In the View panel, click anywhere in the chart to select it. 

3. Select the Properties > Selected Item Properties tab to display controls for changing 
properties.
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4. Make changes by setting the properties in the Properties > Selected Item tab, as described 
in the following sections:

– “Changing a Chart Name” on page 6-17

– “Creating a Y-Axis Label for a Chart” on page 6-18

– “Setting a Chart Graphing Style” on page 6-18

– “Turning a Chart Legend On and Off” on page 6-19

– “Turning a Chart Scrollbar On and Off” on page 6-20

– “Changing Chart Foreground and Background Colors” on page 6-21

5. Click the Apply Changes button to apply your changes to the selected chart. 

Note: You can change some properties directly in the View panel. For example, you can 
right-click a chart name or view name to display an edit field and then type a new 
name in the field. In that case, you do not have to click Apply Changes. Just click 
outside the text box to see your changes.

Alternatively, click Discard Changes to restore the settings that were in effect when you 
started changing them, or click Restore Defaults to restore the WLDF Console Extension 
default settings for charts.

Note: Applying a change to a property does not save it for future use. See step 6.

6. If this is a chart in a custom view, you can save the changes so they will be restored the next 
time you open the WLDF Console Extension. (You cannot save changes to a chart in a 
built-in view.) To save a custom chart, you must save the view, as follows:

a. Select the Views tab.

b. Click the Save button. 

Alternatively, on the toolbar, click the  (Save All Modified Views) button.

Note: You cannot save changes to the properties of a chart in a built-in view.

Changing a Chart Name
You can change the name of charts in built-in and custom views. But you can save the name only 
for charts in custom views. To change the name of a chart:

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in 
steps 1-3 in “Setting Chart Properties” on page 6-16.
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2. Select the General subtab.

3. Enter a new name in the Name field. 

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart 
Properties” on page 6-16. 

Alternatively:

1. Display the view containing the chart.

2. Right click the name at the top of the chart.

3. Type a new name in the field.

4. Click anywhere outside the field to apply the change.

5. Save the changes, as explained in step 6 of “Setting Chart Properties” on page 6-16. 

Creating a Y-Axis Label for a Chart
No Y-Axis label is assigned by default for a chart, but you can create one, as follows:

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in 
steps 1-3 in “Setting Chart Properties” on page 6-16.

2. Select the General subtab.

3. In the Y-Axis field, enter text to be used as the Y-Axis label. 

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart 
Properties” on page 6-16. 

Setting a Chart Graphing Style
By default, graphs are created using the “plot” style (dots connected by lines). However, you can 
change the style, as follows:

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in 
steps 1-3 in “Setting Chart Properties” on page 6-16.

2. Select the General subtab.
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3. Select a style from the Style drop down list to change the visual style of each graph on the 
selected chart. Styles include: 

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart 
Properties” on page 6-16. 

Turning a Chart Legend On and Off
A chart’s legend identifies each graph on the chart. Each line in the legend shows the color and 
graphic used to plot the data points and identifies the data source for the graph.

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in 
steps 1-3 in “Setting Chart Properties” on page 6-16.

Style Example Description

Area Solid area under a line 

Area radar Circular area, with new data sweeping 
clockwise, as with a radar

Bar Bars alternating for each graph

Plot Sequential dots connected by lines

Scatter plot Dots only

Stacking area Areas for each graph, stacked on top of each 
other

Stacking bar Bars for each graph, one stacked on top of the 
other
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2. Select the General subtab.

3. Check the Legends checkbox to display the legend, or uncheck it to hide the legend.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart 
Properties” on page 6-16. 

Alternatively:

1. Display the view containing the chart.

2. Right-click anywhere in the chart.

3. Choose Show Legend from the context menu to display the legend, or choose Hide 
Legend to hide the legend.

4. Save the changes, as explained in step 6 of “Setting Chart Properties” on page 6-16. 

Turning a Chart Scrollbar On and Off
You can use the scrollbar to scroll back through historical data and the attached zoom controls to 
zoom in and out of data, as explained in “Scrolling and Zooming the Data Displayed in a Chart” 
on page 6-12. The scrollbar is hidden by default, however, you can display it and hide it again, as 
follows:

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in step 
1-3 in “Setting Chart Properties” on page 6-16.

2. Select the General subtab.

3. Check the Scrollbar checkbox to display the scrollbar, or uncheck it to hide the scrollbar.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart 
Properties” on page 6-16. 

Alternatively:

1. Display the view containing the chart.

2. Right-click anywhere in the chart.

3. from the context menu, select Hide Legend to turn the legend off, or select Display 
Legend to turn the legend back on.

4. Save the changes, as explained in step 6 of “Setting Chart Properties” on page 6-16. 
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Changing Chart Foreground and Background Colors
The foreground color for a chart includes the color of the text used for the legend and the color 
of the X- and Y-axis lines and values. The background color is the color used for the background 
of the entire chart.

1. Select the chart and select the Properties > Selected Item Properties tab, as explained in 
steps 1-3 in “Setting Chart Properties” on page 6-16.

2. Click the Colors > Foreground subtab to change the foreground colors, or click the Colors 
> Background subtab to change the background colors. 

3. Select your preferred color chooser, by clicking one of the subtabs: Swatches, HSB, or 
RGB.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Chart 
Properties” on page 6-16. 

Setting Graph Properties
When you create a graph in a chart, it is created with default visual and control properties. To 
change those properties:

1. Select the Views tab and select the view containing the chart with the graph whose properties 
you want to change.

2. In the View panel, select the graph in either of the following ways:

– Shift-click anywhere on the graph.

– Shift-click on the legend entry for the graph.

3. Select the Properties > Selected Item Properties tab to display controls for changing 
graph properties.

4. Make changes by setting the properties in the Properties > Selected Item tab, as described 
in the following sections:

– “Changing a Graph Name” on page 6-22

– “Changing a Graph’s Colors” on page 6-23

5. Click the Apply Changes button to apply your changes to the selected chart. 
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Alternatively, click Discard Changes to restore the settings that were in effect when you 
started changing them, or click Restore Defaults to restore the WLDF Console Extension 
default settings for charts.

Note: Applying a change to a property doesn’t save it for future use. See step 6.

6. If this graph is in a chart in a custom view, you can save the changes so they will be restored 
the next time you open the WLDF Console Extension. (You cannot save changes to a chart 
in a built-in view.) To save a custom chart, you must save the view, as follows:

a. Select the Views tab.

b. Click the Save button. 

Alternatively, on the toolbar, click the  (Save All Modified Views) button.

Note: You cannot save changes to the properties of a chart in a built-in view.

Changing a Graph Name
When you drag an item onto a chart to create a graph of the item’s data points, a name is assigned 
by default. This name appears in the legend for the chart containing the graph. You can change 
the name, as follows:

1. Select the graph and select the Properties > Selected Item Properties tab, as explained in 
steps 1-3 in “Setting Graph Properties” on page 6-21.

2. Click the General subtab.

3. Enter a new name in the Name field.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Graph 
Properties” on page 6-21. 

Changing a Graph Scaling Factor
Adjusting the scaling factor for a graph adjusts the units used for the Y-Axis. For example, if a 
Y-Axis unit of 60,000 is scaled to 1, and you change the scaling factor to 10, the units are changed 
to 600,000. Changing the scaling factor of a graph is useful when a chart contains more than one 
graph, and you want to adjust the different graphs to be able to see them in relation to each other.

1. Select the graph and select the Properties > Selected Item Properties tab, as explained in 
steps 1-3 in “Setting Graph Properties” on page 6-21.
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2. Select the General subtab.

3. Select a scaling factor from the Scale dropdown list.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Graph 
Properties” on page 6-21. 

Changing a Graph’s Colors
The foreground color for a graph includes the color of the line and symbols used to plot data in 
the graph, where appropriate. The background color is the fill color for the graph, where 
appropriate for the selected graph style. These colors are assigned by default, but you can change 
them, as follows:

1. Select the graph and select the Properties > Selected Item Properties tab, as explained in 
steps 1-3 in “Setting Graph Properties” on page 6-21.

2. Click the Colors > Foreground subtab to change the foreground colors, or click the Colors 
> Background subtab to change the background colors. 

3. Select your preferred color chooser, by clicking one of the subtabs: Swatches, HSB, or 
RGB.

4. Apply, revert, or save the changes, as explained in steps 5 and 6 of “Setting Graph 
Properties” on page 6-21. 

Working with Metrics Charts and Graphs
Metrics charts and graphs plot the values of MBean instances and attributes. The values can be 
real-time polled metric values obtained from a running WebLogic Server, or they can provide a 
historical view of that metric value for all metrics maintained by the WLDF Harvester.

To create charts and graphs based on metrics data, you drag metrics attributes from the Metrics 
tab to the View panel. Each new graph shows the value of the selected attribute over time. 

The following sections describe how to work with Metrics charts and graphs:

“Understanding the Contents of the MBean Tree in the Metrics Tab” on page 6-24

“Displaying Items in the Metrics tab” on page 6-25

“Displaying Details About MBean Instances and Attributes in the Metrics Tab” on 
page 6-25

“Displaying Details About Metrics Charts and Graphs” on page 6-25
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“Selecting a Server” on page 6-27

Understanding the Contents of the MBean Tree in the Metrics 
Tab
The Metrics tab displays a tree containing the following:

WebLogic MBean types

Currently registered instances of the WebLogic MBean types

Currently registered instances of custom MBean types

Attributes of the listed registered instances

The following visual cues help to identify items in the tree:

Visual Cue Description Represents...

Blue “W” icon WebLogic MBean type

Green “J” icon  JMX MBean type

Pink “C” icon Custom MBean type

Grey dot Attribute of an MBean instance

MBean type icon with the 
type name in normal font

An MBean type with at least one 
registered instance

MBean type icon with the 
type name in grey, italic font

An MBean type with no registered 
instances

MBean instance name 
beneath MBean type name

A registered instance of the MBean 
type

Grey dot next to attribute 
name, beneath MBean 
instance name

An attribute of a registered MBean 
instance
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Displaying Items in the Metrics tab
The tree shows the MBean types, instances, and attributes for a server. Display items in the 
Metrics tab, as follows:

To view the MBeans from a different server in the domain, select the server from the 
Select server dropdown list. (You can display MBeans from only one server instance at a 
time, but you can create a chart using data from more than one server.)

To refresh the tree for the selected server, click the Reload button.

To show all currently registered instances of a listed MBean type, click the  (Expand) 
button to the left of the type name.

To show all attributes of a listed MBean instance, click the  (Expand) button to the left 
of the left of the MBean name.

Displaying Details About MBean Instances and Attributes in 
the Metrics Tab
You can display details about MBean instances and attributes by placing the mouse pointer over 
items in the tree of MBeans displayed in the Metrics tab:

Point to an MBean instance name to display the full object name of the MBean instance.

Point to an MBean attribute name to display the type and description of the attribute.

For more information about displaying these kinds of details, see “Displaying Tooltips for 
Controls, Views, Graphs, and Charts.”

Displaying Details About Metrics Charts and Graphs
You can display details about Metrics charts and graphs displayed in the View panel by pointing 
the mouse pointer at objects in the panel:

Point to a data point in a graph to display the time the data point was plotted and the 
sampled metric value at that time.

Point to a chart legend to display the object instance name for each attribute listed in the 
legend.

Point to a chart scrollbar to display the beginning data and time and the ending date and 
time for the visible interval. This tooltip also tells if this interval is the current interval.
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For information about displaying these details, see “Displaying Tooltips for Controls, Views, 
Graphs, and Charts.”

Working with Method Performance Charts and Graphs
Method Performance charts and graphs plot method performance information that is based upon 
the real-time and historical views of method performance that can be captured through the WLDF 
instrumentation capabilities. 

The following sections describe how to work with Method Performance charts and graphs:

“Making Instrumentation Data Available for Method Performance Charts” on page 6-26

“Selecting a Server” on page 6-27

“Creating Method Performance Charts and Graphs” on page 6-27

“Displaying Requests and Methods in the Requests Tab” on page 6-27

“Displaying Details About Requests” on page 6-28

“Displaying Details About Instrumentation Events” on page 6-29

“Displaying Details about Requests and Methods in the Requests Tab” on page 6-31

“Selecting a Time Interval for a Method Performance Graph” on page 6-32

“Displaying Details About Method Performance Charts” on page 6-32

Making Instrumentation Data Available for Method 
Performance Charts
You must configure WLDF instrumentation outside of the WLDF Console Extension to make 
instrumentation data available for creating Method Perfomance charts and graphs. If 
instrumenation is not configured and enabled for the selected server, no data will appear in the 
Requests tab. 

To configure instrumentation, you must create a weblogic-diagnostics.xml descriptor using 
the WebLogic Server Administration Console, using the WebLogic Scripting Tool (WLST), or 
manually. See ”Configuring Instrumentation” in Configuring and Using the WebLogic 
Diagnostic Framework for more information.

http://e-docs.bea.com/wls/docs91/wldf_configuring/config_instrumentation.html
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Selecting a Server
The Requests tab displays instrumented methods available for a single server at a time. To select 
a different server, select the server from the Select server dropdown list. The Select server 
dropdown list displays all the servers in the domain.

Creating Method Performance Charts and Graphs
To create and modify charts and graphs based on instrumented methods, you drag methods from 
the Requests tab to the View panel to create or modify a Method Performance chart. Each graph 
shows the elapsed invocation times of the selected method over time. 

Figure 6-11  Requests Tree and a Method Performance Chart

Displaying Requests and Methods in the Requests Tab
The Requests tab shows information about requests that flow through instrumented code. When 
such requests execute instrumented methods, instrumentation events are generated at the start and 
end of the methods. 

The Requests tab includes a tree of method calls for identified requests. At the top level, the tree 
shows all identified requests from the specified server within a specified interval, as shown in 
Figure 6-12.
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Figure 6-12  Requests Listed in the Requests Tab

Requests are identified by:

A unique request ID 

The name of the application

Information about the top level method executed by the request

The execution time of the request is shown by a horizontal bar, whose length is 
proportional to its execution time

Expanding a request node shows its top level instrumented method, as shown in Figure 6-13. 
Within the call tree, if a method calls other instrumented methods, they are shown as its children. 
A method node in the call tree shows the instrumented class and method name. 

Figure 6-13  Expanded Request Node in the Requests Tab

Displaying Details About Requests
To display details about a request listed in the Requests tree, click the string that identifies the 
request (not the . (Expand) or . (Collapse) buttons). The information is displayed in the 
panel below the tree, as shown in Figure 6-14. 
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Figure 6-14  Details About a Request

The attributes listed in this panel are described in Table 6-2. 

Displaying Details About Instrumentation Events
To display details about the instrumentation event associated with a method, click the method 
node. The information is displayed in the panel below the call tree, as shown in Table 6-3. 

Table 6-2  Request Values Displayed in Request Panel

Attribute Description

Class Name A Java class containing a method that handled this request.

Method The method that handled this request.

Count The number of times this method handled this request.

Total Time (ms) The total time taken by this method to handle this request, in 
milliseconds.

Average Time (ms) The average time taken by this method to handle this request, in 
milliseconds.

Scope The scope of the class containing the instrumented code. 

Module  The application module containing this class.

Signature The signature of the method.
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Figure 6-15  Details About an Event

The attributes listed in this panel are described in Table 6-3. 

Table 6-3  Event Values Displayed in Request Panel

Attribute Description

RECORDID Unique identifier to identify this record in the log.

TIMESTAMP Date when this event was generated.

CONTEXTID Diagnostic context information to correlate messages coming from a 
specific request or application.

TXID The identifier for the transaction that initiated this diagnostic event. 
Present only for messages logged in the context of a transaction.

USERID The user ID under which this diagnostic event was executed.

TYPE Type of diagnostic action triggered by this diagnostic event.

DOMAIN Domain in which this event was generated.

SERVER The name of the WebLogic Server instance on which this event was 
generated.

SCOPE Server or application scope in which this diagnostic event was 
generated.

MODULE Diagnostic module through which this diagnostic event was 
generated.

MONITOR Diagnostic monitor that triggered this diagnostic event.
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Displaying Details about Requests and Methods in the 
Requests Tab
You can display details about the requests and method calls by placing the mouse pointer over 
items in the tree of requests and methods displayed in the Requests tab:

Point to a request node to display the request ID, request start time, and request elapsed 
time.

Point to a method invocation node to display the method elapsed time, percentage with 
respect to the parent method, and application name.

For more information about displaying these kinds of details, see “Displaying Tooltips for 
Controls, Views, Graphs, and Charts.” 

FILENAME Name of the Java file containing the instrumented method that 
generated this diagnostic event.

LINENUM Line in the source file where instrumented code exists.

CLASSNAME Name of the Java class containing the instrumented method.

METHODNAME Name of the instrumented method that generated this diagnostic 
event.

METHODDSC The descriptor of the method that generated this diagnostic event.

PAYLOAD The payload.

CTXPAYLOAD The diagnostic context payload associated with diagnostic event.

DYES The diagnostic dyes associated with the method that initiated this 
event.

Table 6-3  Event Values Displayed in Request Panel

Attribute Description
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Selecting a Time Interval for a Method Performance Graph
You can create a graph based on events executed during a specified time interval, as described in 
the following table: 

Displaying Details About Method Performance Charts
You can display details about Method Performance charts and graphs displayed in the View 
panel:

Point to a data point in a graph to display the time the data point was plotted and its value 
when it was plotted, in nanoseconds. 

Point to a chart’s scroll bar to display the beginning date and time and ending date and 
time for the visible interval. This tooltip also reports if the interval is the current interval.

Point to a chart’s legend to display the following for each entry in the legend:

To specify a predefined 
interval that ends in the 
present

From the Interval drop down list, select one of the following:
• Last 5 minutes to display events data for the previous five minutes
• Last 15 minutes to display events data for the previous fifteen 

minutes
• Last 30 minutes to display events data for the previous 30 minutes
• Last 1 hour to display events data for the previous hour

To specify a custom 
interval that ends the 
present

1. From the Interval drop down list, select Last dd hh mm. The 
Duration (DD HH MM) text entry field appears.

2. Enter a value for the interval, in the format DD HH MM, where 
- DD is the number of previous days
- HH is the number of previous hours
- MM is the number of previous hours 

To specify a custom 
interval that may not end 
in the present:

1. From the Interval drop down list, select Custom. A set of fields for 
entering the duration appears. 

2. Click the Start drop down control to display a calendar. Select a start 
date.

3. Specify a starting hour and minute by replacing HH MM in the text 
entry box with the starting hour and minutes.

4. Enter a duration by replacing DD HH MM in the Duration text entry 
box with the desired days, hours, and minutes. 
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– Class name containing the instrumented method

– Scope of the instrumented method

– Signature of the instrumented method

For information about displaying these details, see “Displaying Tooltips for Controls, Views, 
Graphs, and Charts.”

Setting Global Polling and View Scrolling Properties
Global properties apply to all active views. To set global properties, click the Properties tab, then 
click the Global Properties subtab. You can set the following properties:

Polled data set size. The number of dynamically gathered samples retained in the data 
cache on the server for each monitored metric. For information about the data caches, see 
Chapter 4, “Understanding How Data Is Collected and Presented.”

Autoscroll Speed. If a view contains several charts, you may have to scroll the window to 
see all the charts. If you drag an item from the Tabs panel towards an edge of such a view, 
the window scrolls so you can add the item to the hidden part of the view. The Autoscroll 
Speed setting sets the speed of the scrolling, in inches per second. 

Autoscroll Insets. The width of the region surrounding a panel that is used to trigger 
automatic scrolling. 
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A P P E N D I X A

Keyboard Reference

Most of the WLDF Console Extension documentation tells how to accomplish tasks using the 
mouse. However, you can accomplish virtually all of those tasks using the keyboard only, as 
described in the following sections:

“Terms and Conventions” on page A-1

“Navigating and Selecting” on page A-2

“Keyboard Reference” on page A-2

Terms and Conventions
The following terms and conventions are used in the table:

Controls are items such as buttons, tabs, text fields, and sliders that you use to perform 
actions or view information. In some circumstances, a control may be disabled, which 
means that it is not available in the current context. For example, if no views have unsaved 
changes, the button for saving all views is disabled, and you are unable to select it using 
the keyboard. In that case, the appearance of the button is changed; for example it may be 
all gray, depending on the platform. 

Two key names separated by a + (plus sign), for example Shift+Tab, indicates that you 
must hold down the first key, then press the second named key, then release both keys.
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Navigating and Selecting
You can use the keyboard to navigate through the WLDF Console Extension, for example, press 
the Tab key to move from one control to the other. However, navigating to a control does not 
initiate an action with the control; it simply makes it available for receiving the next keyboard 
input. For example, you can press Tab to navigate to a button but you must then press Enter to 
press the button. In most cases, this is straightforward, and you do not have to be aware of the 
distinction. A visual cue indicates that an item is selected. For example, a chart is surrounded by 
a box, or the data points and (legend entry icon) in a scatter plot graph may be displayed as stars. 
(The visual cues may be different on different platforms.)

The WLDF Console Extension has two main panels, the Tabs panel and the View panel, and one 
of those tabs is always active. Keyboard input affects whatever control is selected in the active 
panel. For example, if an edit field is selected in the active panel, any characters you type on the 
keyboard are added to that edit field.

Certain actions affect the selected item in the panel that is not active. For example, you can 
navigate to a chart in the View panel and select the chart. You can then navigate to the Selected 
Item Properties tab in the Tabs panel and make a change to a property (that is, select the control 
that sets the property’s value, change the value, navigate to the Apply Changes button, and press 
Enter to push the button). When you apply the changes, the property is changed in the chart 
selected in the (non-active) View tab.

The  (Focus Context) button on the toolbar indicates which panel is active. When the 
arrow on the button points left, the Tabs panel (on the left) is active. When it points right, the 
View panel (on the right) is active.

Keyboard Reference
Table A-1 describes how to use the keyboard to accomplish tasks in the WLDF Console 
Extension.
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Table A-1  WLDF Console Extension Keyboard Access 

Pressing this key 
or these keys...

When this item is 
selected...

Does this...

Enter Any button Presses the button.

Tab Tabs panel 
(the panel on the left side 
of the page)

Selects the next active control. Repeatedly pressing the 
Tab key cycles through all active controls in the toolbar 
and the current tab. (That is, one control after another is 
selected, while the previously selected control is 
deslected. After the last control is selected, pressing the 
Tab key again starts the process again.)

Shift+Tab Tabs panel Same as Tab, above, but selects the previous instead of 
the next active control.

Tab View panel 
(the panel on the right 
side of the page)

Selects the next chart in the view. Repeatedly pressing 
the Tab key cycles through all the charts.

Shift+Tab View panel Same as Tab, above, but selects the previous instead of 
the next chart.

→ 

(Right arrow)

Toolbar Selects the next active button in the toolbar. Repeatedly 
pressing the arrows cycles through the active buttons in 
the toolbar.

← 

(Left arrow)

Toolbar Same as →, above, but selects the previous instead of the 
next button.

→ 

(Right arrow)

Tab controls (labels) in 
the Tabs panel

Selects the next tab. Repeatedly pressing the arrows 
cycles through all tabs.

← 

(Left arrow)

Tab controls (labels) in 
the Tabs panel

Same as →, above, but selects the previous instead of the 
next tab.

↓ 

(Down arrow)

Tree of view names in 
the Views tab 

Selects the next view or folder.

↑  

(Up arrow)

Tree of view names in 
the Views tab 

Selects the previous view or folder.
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Shift+→ 

(Right arrow)

View panel Selects the next chart in the current view. Repeatedly 
pressing the Shift+→ cycles through all the charts in the 
view.

Note: If the Tabs panel is active when you click 
Shift+→, the View panel becomes active, and 
the next chart is selected.

Shift+← 

(Left arrow)

View panel Same as Shift+→, above, but selects the previous 
instead of the next chart.

Shift+↓ 

(Down arrow)

View panel Selects the next graph in the current chart, or if there are 
no more graphs in the chart, selects the first graph in the 
next chart. Repeatedly pressing Shift+↓ cycles through 
all the graphs in all the charts in the view.

Note: If the Tabs panel has is active when you click 
Shift+↓, the View panel becomes active, and 
the next graph is selected.

Shift+↑  

(Up arrow)

View panel Same as Shift+←, above, but selects the previous 
instead of the next graph.

↓ 

(Down arrow)

View panel Scrolls the contents of the panel up, if they extend 
beyond the visible area.

↑  

(Up arrow)

View panel Scrolls the contents of the panel down, if they extend 
beyond the visible area.

→ 

(Right arrow)

Slider control Moves the slider control to the right.

← 

(Left arrow)

Slider control Moves the slider control to the left.

Space bar Check box Selects or deselects the check box.

Pressing this key 
or these keys...

When this item is 
selected...

Does this...
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r Chart in the View panel. Displays current data in the selected chart. You can use 
this to return to showing current data after viewing 
historical data.

Esc Anywhere Deselects the currently selected item(s). 

If an in-place edit field is selected (for example, you can 
right-click the name of the view or of a chart in the 
View panel to edit it), pressing Esc first deselects the 
edit field. Pressing Esc again deselects the chart.

Del Anywhere Deletes the currently selected item.

Pressing this key 
or these keys...

When this item is 
selected...

Does this...
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